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Terminologies

MSOP Main data Stream Output Protocol

DIFOP Device Info Output Protocol

FOV Field Of View

PTP Precision Time Protocol

GPS Global Positioning System

UTC Universal Time Coordinated

Protocol
Protocol version number, 00 represents old version, 01
represents the latest version

Wave_mode Echo flag

Temp LiDAR temperature information

Resv Reserved data flag

UCWP User Configuration Write Protocol

Azimuth LiDAR horizontal rotation angle

Timestamp Time stamp which is used to record system time

Header Frame header in protocol packet

Tail Frame tail in protocol packet
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1. Manufacturer Information

Suteng Innovation Technology Co., Ltd. (RoboSense)

Buliding 9, Block 2, Zhongguan Honghualing Industry Southern District, 1213 Liuxian Avenue,
Taoyuan Street, Nanshan District, Shenzhen, China

Landline: 0755-86325830

Mobile Phone: +86 13651448823(Marketing & Sales)

Email: service@robosense.cn

Working hours from Monday to Friday 09:00-18:00(GMT/UTC +8)

2. Disclaimer of Liability

This manual is protected by copyright. Any rights arising from this copyright are owned by
RoboSense. Reproduction of this manual or part of the manual is only permitted within the legal
scope of the copyright law. Without obtaining any authorization, this document shall not be
abridged or translated. The trademarks mentioned in this document are the property of their
respective owners. RoboSense reserves all rights.

3. Certifications

特别说明：

This manual is updated from time to time without prior notice, to get the latest version, please
visit RoboSense company website to download or contact the RoboSense Technical Support or
Sales.
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1. Safety Notices

To avoid risks of accidents, damage to sensor or violating of your product warranty, please read
and follow the instructions in this manual carefully before operating the product.

 Laser Safety

This product meets the following standards for laser products:

IEC 60825-1:2014;

 Sensor Overheating Sign

Please pay attention to the overheating sign on the LiDAR surface to avoid a hot LiDAR surface
that may lead to sensor failure or undesirable consequences.

 Read Instructions – Please reading all instructions on sensor operation and use

 Retain Instructions – The safety and operating instructions should be retained for future
reference.

 Heed Warnings - All warnings on the product and in the operating instructions should be
adhered to.

 Servicing – Except for what’s described in this manual, the sensor has no field serviceable
parts. For servicing, please contact RoboSense sales or the authorized distributors.
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2. Product Appearance and Interface

2.1.Product Appearance

Figure 2-1 LiDAR Coordinates and Rotation Direction

2.2.Aviation Plug and Pin Definition

The data output access of the RS-Bpearl is physically protected by an aviation plug. From the
LiDAR to the aviation plug the cable length is 1 meter. The pins of the aviation plug are defined as
follows:

Figure 2-2 RS-Bpearl Aviation Plug

Table 2-1 Definition of Pins of Aviation Plug of RS-Bpearl

Pin Wire Color Function

1 Red +12V

2 Yellow +12V

3 White GROUND

4 Black GROUND
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5 Green GPS PULSE

6 Blue GPS REC

7 Brown LiDAR Ethernet RX+

8 Brown white LiDAR Ethernet RX-

9 Orange LiDAR Ethernet TX+

10 Orange white LiDAR Ethernet TX-

2.3. Interface Box

Your RS-Bpearl comes with an Interface Box, which has 2 LED lights and provides convenient
connections to power, RJ45 Ethernet, and GPS. (The length of the integrated cable attached to
the Interface Box of the aviation plug version LiDAR is 3 meters, for other cable lengths, please
contact RoboSense technical support).

Figure 2-3 Definition of Interface Box Ports

Specifications of Interface Box ports:

Table 2-2 Interface Box Port Specification

No. Port Specification

1 Power Input Standard DC 5.5-2.1 connector

2 Network Standard RJ45 Ethernet connector

3 GPS timing SH1.0-6P Female connector

1.1.1 Power

The power supply interface of the RS-Bpearl on the Interface Box is a standard DC 5.5-2.1

1

2

3
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connector.

There are 2 LEDs (power indicators) on the Interface Box: when the power input is normal, the
red LED is on, the green LED is always on by default. When the red LED is off, the Interface BOX
enters the protection state. If either LED (when connected to GPS) is off, please check whether
the power input is normal; If the power input is normal, the Interface BOX may be damaged.
Please contact your technical support or account manager at RoboSense.

1.1.2 RJ45 Ethernet Port

The network interface on the Interface Box follows the EIA/TIA568 standard.

1.1.3 GPS Time Synchronization

GPS REC receives GPS UART standard input; GPS PULSE receives GPS PPS input.

The definitions of pins of the GPS port are detailed in the figure below:

Table 2-3 GPS Port Definition

Pin No. function

1 GPS_PULSE

2 +5V

3 GND

4 GPS_REC

5 GND

6 NC

Note: When the "ground" of RS-Bpearls is connected to an external system, the negative polarity ("ground") of

the external system and the "ground" of the GPS system must share a non-isolated common ground.



RS-Bpearl User manual

11

3. Unboxing & Installation
3.1.Standard Package

The table below lists the contents of a standard RS-Bpearl package from the factory.

Table 3-1 Standard Factory Package of the RS-Bpearl

No. Contents SPEC/QTY

1 LiDAR RS-Bpearl*1

2 Interface Box 3M *1

3 Power Adapter DC12Vx3.34A/40W *1

4 Power Cable 1.2M *1

5 Ethernet Cable 1.5M *1

6 Screw Pack M4x15 *3；M4x20 *3

Note: There might be variants of the sensor and accessories that you are going to purchase or
interested in, please contact RoboSense Sales for details.

3.2.Sensor Mounting

The RS-Bpearl can be mounted to any application with a mounting base. As shown in the figure
below, the mounting base of the RS-Bpearl should be flat, uneven surfaces should be avoided.
The precise locator pins on the mounting base should strictly follow the dimensions of the locator
holes at the bottom of the LiDAR, and the height of the locator pin should not be higher than
4mm. We recommend using aluminum alloy for the mounting base material, which facilitates
heat dissipating of the LiDAR during operating.
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Figure 3-1 LiDAR Mounting Details

The following situations should be avoided when mounting the LiDAR:

1) The reserved mounting space for the LiDAR is smaller than the volume of the LiDAR itself.

2) The integrated sensor cable is too tight.

3.3.Quick Connection

Users are allowed to configure the network settings of the RS-Bpearl, which is set at the factory
with default IP and port numbers, as shown in the table below:

Table 3-2 actory Default Network Configuration

IP Address MSOP Port No. DIFOP Port No.

RS-Bpearl 192.168.1.200

6699 7788

Computer 192.168.1.102

To establish communication between the LiDAR and computer, it’s required to set the computer's
IP address to the same network segment as the LiDAR, for example 192.168.1.x (the value of x
could be from 1 to 254), and the subnet mask to 255.255.255.0. If you don't know the network
configuration of the LiDAR, please connect the LiDAR to computer and use wireshark to capture
the LiDAR data packets to analyze.

The wiring diagram of the Interface Box connection is as shown in the figure below:

3xM4 Screws, 6-8 mm above mounting surface;
25kgf.cm recommended tightening torque

2xΦ3.97±0.03 locating pins, 3-4
mm above mounting surface
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Figure 3-2 Interface Box Connection

To GPS

Interface Box

To power adapter

To PC Network
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4. Sensor Specifications and Features
4.1.Sensor Specification1

Table 4-1 Sensor Specifications

Sensor

Laser Channels 32 FOV(Horizontal) 360°

Laser Wavelength 905nm FOV(Vertical) 0°~90°

Laser Emission Angle Horizontal(maximum): 9 mrad， Angular Resolution (Horizontal) 0.1°/ 0.2°/ 0.4°

Laser Safety Class 1 Eye-safe Angular Resolution (Vertical) 2.81°

Measurement Range2 0.1m to 30m(10%NIST targets） Ranging Accuracy (Typical)3 Up to ±3cm

Blind Distance ≤0.1m Frame Rate 5Hz/10Hz/20Hz

Rotation Speed 300/600/1200rmp(5/10/20Hz)/

Output

Data Rate 5576,000pts/s (Single Return Mode); 1,152,000pts/s(Dual Return Mode)

Ethernet 100Mbps

Data Output Protocol UDP packets over Ethernet

UDP Packets Content Distance, Calibrated Reflectivity Measurements, Time Stamps

Mechanical

Operating Voltage 9V-32V Dimension φ100mm * H111 mm

Power Consumption4 13w(Typical) Operating Temperature5 -20℃~+60℃5

Weight 0.92kg (LiDAR） Storage Temperature -40℃~+85℃

Time Synchronization $GPRMC with 1 PPS & PTP Sensor Protection IP67

1 The data above is only for serial production products, and may not be applicable to any samples, testing devices
and other non-production versions. If you have any questions, please contact RoboSense Sales.

2. The measurement range takes a 10% NIST diffuse reflector as the target, and the test results may be affected
by environment conditions, including but not limited to factors such as ambient temperature and light

3 The ranging accuracy takes a 50% NIST diffuse reflector as the target. The test results may be affected by
environment conditions, including but not limited to factors such as ambient temperature and target distance.
The accuracy value is applicable to most channels, and there may exists differences between some channels.

4 The power consumption of the device may be affected by environment conditions, including but not limited to
factors such as ambient temperature, target distance, target reflectivity, etc.

5 The operating temperature of the device may be affected by environment conditions, including but not limited
to factors such as ambient light and airflow changes.
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4.2.Point Cloud Display
4.2.1. Coordinate Mapping

Since the data packet output by the LiDAR only provides the horizontal rotation angle and
distance infomation, in order to present a 3D point cloud image, the angle and distance
information in polar coordinates need to be converted into x, y, z coordinates in the Cartesian
coordinate system, and the conversion formula is as follows:

� = � ��� ( �) ��� ( � + �);
� = � ��� ( �) ��� ( � + �);

� = � ��� ( �);

Where � is the measured distance,  is the vertical angle of the laser,  is the horizontal
rotation angle of the laser in the Polar Coordinate System, and x, y, z are the coordinate values in
the Cartesian Coordinate System.

 and � can be obtained from the DIFOP data packets, please refer to B.14 and B.15 in

Appendix B for details.

Figure 4-1 LiDAR Polar Coordinates

Note 1: ROS source code of RS-Helios has by default completed the coordinate conversion to conform to the

right-handed coordinate system of ROS. The X-axis of ROS is the positive Y direction in Figure 4-1, and the Y-axis

of ROS is the negative X direction in Figure 4-1.

Note 2: The origin of the LiDAR sensor coordinate is at the center of the LiDAR base.
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4.3.Reflectivity

RS-Bpearl measures the reflectivity of objects. The reflectivity is an index that measures the
ability of an object to reflect light and is greatly related to the material of the object itself.

RS-Bpearl reports calibrated reflectivity values from 0 to 255, among which diffuse reflectors
report values from 0 to 100, and retroreflectors report values from 101 to 255. Black objects are
with low reflectivity values, white objects are with high reflectivity values, the most ideal
reflection reports the reflectivity value of 255.

Figure 4-2 Definition of Reflectivity

Diffuse Reflectors

Black, absorbent diffuse reflector
Reflectivity ≈0

White, reflective diffuse reflector
Reflectivity <100

Retro-Reflectors

Retro-reflector covered with semi-transparent
white surface
Reflectivity>100

Retro-reflector without any coverage
Reflectibity≈255
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4.4.Laser Return Modes
4.4.1. Principle of Laser Return Modes

RS-Bpearl supports multiple laser return modes, namely: Strongest Return, Last Return and Dual
Return. When set to Dual Return mode, the details of the target will increase, and the volume of
data is twice that in the Single Return mode.

Due to beam divergence, multiple laser returns are possible from any single laser shot. A pulse
may diverge and becomes larger as it travels in the air, when a pulse is large enough to hit
multiple objects, it will produce multiple reflections. Usually, the farther away the object is, the
weaker the energy of the pulse arrived at the receiver. For bright or retroreflective surfaces, the
situation may be the opposite.

RS-Bpearl analyzes the received multiple returns, and reports the strongest return, last return or
dual returns at the same time, depending on the laser return mode settings. If the LiDAR is set to
the strongest return mode, only the value of strongest return will be reported. Similarly, if the
LiDAR is set to the last return mode, only the value of the last return will be reported. If the LiDAR
is set the dual return mode, both the strongest and last return value will be reported.

Note:

1. The sensor records both returns only when the distance between two objects is 1 meter or more.

2. When a laser pulse hits only one object, there is only the strongest return.

3. When a laser pulse hits two solid walls or other objects at two different distances, two returns will be produced.

In this case, there are two situations:

(1) When the strongest return is not the last return, the strongest and last return will be reported;

(2) When the strongest return is the last return, the strongest return and the second strongest
return will be reported.

4.4.2. Return Mode Flag

The RS-Bpearl is set in the Strongest Return mode at factory by default. If you need to change this
settings, please refer to Figure C14 in Appendix C RSView of this user manual for instructions. The
300th byte in a DIFOP packet is the flag of return mode, which corresponds to the following:

Table 4-2 Return Mode and the Corresponding Flag

Flag Return Mode

00 Dual Return

01 Strongest Return

02 Last Return
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4.5.Phase Locking

To minimize interference between multiple LiDARs, RS-Bpearl provides a phase-locking feature
that enables users to control where the lase firings overlap.

The phase locking feature, when a PPS pulse signal is triggered, askes the RS-Helios to rotate to a
specific angle to fire laser pulses. When multiple RS-Helios sensors are used at the same time, the
relative rotation angle between them is kept unchanged. The normal phase locking requires the
normal and stable PPS pulse triggering signal.

Figure 4-3 shows the RS-Bpearl set with different phases. The red arrows indicate the firing angle
of the sensor’s laser at the moment it receives the rising edge of the PPS signal. In the cases
below: 0 degrees, 135 degrees, and 270 degrees respectively.

Figure 4-3 RS-Bpearl Different Phase Settings

For the RS-Bpearl_2.0, users can use the RS-Bpearl RSView to check and modify the Phase
Locking settings: click Tools > RS-LiDAR Information for the "Phase Lock" parameter setting. The
phase locking value can be set from 0 to 359.

For the RS-Bpearl_3.0, users can use the RS-Bpearl Web Interface to check and modify the Phase
Locking settings: click Setting > Phase Lock Setting, for the "Phase Lock" parameter setting. The
phase locking value can be set from 0 to 359.

The Phase Lock feature will only be available when the rotation speed of the RS-Bpearl is set as
600RPM or 1200RPM.

4.6.Time Synchronization

The RS-Bpearl_2.0 only supports GPS+PPS time synchronization, while the RS-Bpearl_3.0
supports both GPS+PPS and PTP/gPTP time synchronization methods. Users can use the
RS-Bpearl Web Interface to set the time synchronization methods (Please refer to Appendix A.2
for instructions of setting at Web Interface.). Both the RS-Bpearl_2.0 and the RS-Bpearl_3.0 can
be connected to an external GPS module, and can synchronize the sensor system time with the
time provided by the GPS.
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4.6.1. GPS Time Synchronization

Figure 4-4 GPS Time Synchronizatio Timing Diagram

The GPS module continuously sends GPRMC message and PPS synchronization pulse signals to
the sensor. The PPS synchronization pulse width is from 20ms to 200ms, and the GPRMC message
must be sent within 500ms after the rising edge of the PPS synchronization pulse.

4.6.2. The Use of GPS for Time Synchronization

The GPS_REC interface in the Interface Box of the RS-Bperl follows the RS232 level standard, as
shown in the table below:

Table 4-3 GPS Receive Pin Definition

Level
Receive Pin Definition

GPS REC GPS PULSE

RS232
Receive the RS232 serial data

output by the GPS module

Receive the positive synchronization

pulse signal output by the GPS module,

the level is required to be 3.0V~15.0V

Note 1: The GPS_REC interface in the RS-Bpearl Interface Box is the SH1.0-6P female connector, and the pin

definition is as shown in Figure 2-3.

The external GPS module needs to set the serial output baud rate to 9600bps, 8 bits, no parity, 1
stop bit. RS-Bpearl only accepts the GPRMC sentence sent by the GPS module. The standard
structure of the GPRMC sentence is as follows:

$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh

<1> UTC Time

<2> Receiver status, A=active, V=void

<3> Latitude

<4> Latitudinal hemisphere N (northern hemisphere) or S (southern hemisphere)

<5> Longitude
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<6> Longitudinal hemisphere E (east longitude) or W (west longitude)

<7> Speed over the ground(knots)

<8> Track made good (degrees True)

<9> UTC date

<10> Magnetic declination

<11> Magnetic declination direction, E (east) or W (west)

<12> Mode indicator (A=autonomous, D=differential, E=estimated, N=not valid)

*The last hh is the XOR sum of all characters from $ to *

Please note that：

1. The sending time interval of 1 PPS pulse needs to be controlled within 1s±100us;

2. The status bit in the GPRMC message must be A valid before time synchronization is allowed;

3. The length of GPRMC messages sent by existing GPS modules on the market is not consistent.
The length of GPRMC messages reserved in the DIFOP packet of RS-Bpearl is up to 86 bytes,
which is compatible with the GPRMC message format sent by most GPS modules on the market.
If an incompatibility occurs, please contact RoboSense technical support.

4.6.3. PTP Time Synchronization

PTP (Precision Time Protocol) is a time synchronization protocol, which itself is only used for
high-precision time synchronization between devices, but it can also be borrowed for frequency
synchronization between devices. Compared with various existing time synchronization
mechanisms, PTP has the following advantages:

1) Compared with NTP (Network Time Protocol, Network Time Protocol), PTP can meet
higher-precision time synchronization requirements. NTP can only achieve sub-second time
synchronization precision, while PTP can reach sub-microsecond time synchronization precision.

2) Compared with GPS (Global Positioning System), PTP requires lower construction and
maintenance costs.

4.6.4. PTP Wiring Diagram (Valid for RS-Bpearl 3.0)

To use the PTP synchronization method, the user need to make the following preparations,
connect devicesaccording to the connection method shown in the figure below:

1) Select PTP mode in the web interface (please refer to Appendix A.2 for Web Interface
configuration);

2) Prepare a PTP Master timing host (plug and play, no additional configuration required);

3) Ethernet switch;

4) Devices supporting PTP protocol
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Figure 4-5 PTP Connecting Diagram

Note:

1. The PTP Master timing equipment is a third-party equipment that needs to be purchased by the user

independently, which is not included in the RoboSense standard product shipping package.

2. As a PTP Slave device, our LiDAR only obtains the time sent by the PTP Master, and does not make accuracy

judgments. If the time of the LiDAR deviates from the real time, please check whether the time provided by the

PTP Master is accurate;

3. After the LiDAR is synchronized, the PTP Master is disconnected, and the time in the point
cloud data packet will be superimposed according to the LiDAR's internal clock, and it will be
reset after the LiDAR is powered off and restarted.

4.6.5. Time Calculation

The MSOP data packet contains time data. When external time synchronization signal is not
available, a default system time will be used for the timing. The sensor time will be updated when
external time synchronization signals are available.

The time stamp in the MSOP data packet could be parsed as below:

1) The time stamp data in the MSOP data packet contains year, month, day, hour, minute,
second, millisecond, and microsecond parts. As shown in Figure 4-6, the year, month, day,
hour, minute, and second are represented by: 0X15, 0X0C, 0X07, 0X03, 0X06, and 0X23;
converted to decimal is: year 2021, month 12, day 7, hour 3, minute 6, second 35.

2) The millisecond and microsecond data are generated from the internal timing of the LiDAR,
the maximum value is 0X03E7 (999); as shown in Figure 4-6, the millisecond and
microsecond parts are represented by: 0Xe1 0X72, 0Xe1 0Xc5; converted to decimal is 370
milliseconds, 453 microseconds.

PTP Master (third party)

LiDAR Configuration Box

Ethernet Switch
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Figure 4-6 Time Stamp

Note:

Red box: Header ID；

Yellow box: Year, month, day, hour, minute, second respectively;

Green box: Millisecond;

Blue box: Microsecond.
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5. Communication Protocols

The communication between RS-Bperl and computer is through Ethernet and by sending UDP
packets. There are mainly three types of communication protocols, as shown in the table below:

Table 5-1 Communication Protocols

Protocol Abbreviation Function Type Packet Size Time Interval
between packets

Main data Stream

Output Protocol
MSOP

Output

measured data
UDP 1248 bytes ~0.66ms

Device Information

Output Protocol
DIFOP

Output sensor

information
UDP 1248 bytes ~1s

User Configuration

Write Protocol
UCWP

Input sensor

configuration

parameters

UDP 1248 bytes INF

Note: The following sections describe and define the valid payload (1248byte) of the protocols.

1) The main data stream output protocol MSOP, encapsulates the distance, angle, reflectivity and other

information measured by the LiDAR into an UDP packet and outputs to the computer;

2) Device information output protocol DIFOP, outputs various configuration information of the current

state LiDAR to the computer;

3）UCWP is only valid for the RS-Bpearl_2.0

4）The time interval between DIFOP packets of the RS-Bpearl_2.0 is about 100ms.

5.1.MSOP and DIFOP

The UDP packet sent by RS-Bpearl has a payload of 1248 bytes, the data structure of the MSOP
packets and the DIFOP packet is as shown in the figure below:
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Figure 5-1 RS-Bpearl_2.0 UDP Packet Structure

Figure 5-2 RS-Bpearl_3.0 UDP Packet Structure
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5.2.Main Data Stream Output Protocol（MSOP）

Main data Stream Output Protocol is abbreviated as MSOP

I/O type: device output, computer analysis

Default port number: 6699

5.2.1. Header

The header has 42 bytes and is used to identify the beginning of the UDP data packet. The
structure of the Header is as shown in the table below:

Among the 42 bytes of the UDP header of the RS-BPearl_2.0, the beginning 8 byts are for the
header identification. For the rest 34 bytes, byte 21 to byte 30 are time stamps, byte 31 identifies
the LiDAR model, the rest bytes are reserved bytes.

The header of the RS-BPearl_3.0 is defined as shown in the table below:

Table 5-2 RS-Bpearl_3.0 MSOP Header Definition

Header（42bytes）

Field Offset Length（byte） Definition

Header ID 0 8

Header ID, 8 bytes in length, used for packet

header identification, defined as

0x55,0xAA,0x05,0x0A,0X5A,0XA5,0X50,0XA0

Checksum 8 4 For internal packet check use

Packet Count 12 4 Packet count

Resv 16 4 Reserved for future updates

Time Stamp 20 10
Store timestamps, Appendix B.10 provides

specific definition

LiDAR Model 30 1

Identify LiDAR model

0x01:RS-LiDAR-16

0x02:RS-LiDAR-32

0x03:RS-Bpearl

0x04:RS-Ruby

0x05:RS-Ruby Lite
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0x06:RS-Helios

Resv 31 7 Reserved for future updates

Temp 38 2 Device temperature

Top Temp 40 2 Top board temperature

Note: The defined time stamp is used for recording the system time, the resolution is 1us.
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5.2.2. Data Blocks

As shown in the table below, the Data Blocks in the MSOP packet store the data measured by the
sensor, and has a total of 1200 bytes. There are a total of 12 data blocks in one MSOP Packet.
Each data block has 100 bytes and represents a complete measurement.

Table 5-3 Data Block Definition

Data Block（1200bytes）

Data Block 1 Data Block 2 Data Block n Data Block 12

0XFFEE 0XFFEE 0XFFEE 0XFFEE

Azimuth 1 Azimuth 2 Azimuth n Azimuth 12

Channel data 1 Channel data 1 Channel data 1 Channel data 1

Channel data 2 Channel data 2 Channel data 2 Channel data 2

... ... ... ... ... ... ... ...

Channel data 31 Channel data 31 Channel data 31 Channel data 31

Channel data 32 Channel data 32 Channel data 32 Channel data 32

Note: In the dual return mode, for each data block, the odd-numbered data blocks reports the last return data,

and the even-numbered data blocks reports the strongest return data.
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5.2.2.1. Channel Data

Each channel data has 3 bytes, the upper two bytes store distance information, and the lower
one byte stores reflectivity information, as shown in the figure below.

Table 5-4 Channel Data

Channel data n （3 bytes）

2 bytes Distance 1 byte Reflectivity

Distance1 [15:8] Distance2 [7:0] Reflectivity

Distance information contains 2 bytes, the unit is m, the resolution is 0.5cm.

Figure 5-3 MSOP Packet

Note:

Red box: Header ID

Orange box: Data Block flag

Green box: Azimuth value of Channel data 1

Blue box: Distance value of Channel data 1

Black box: Reflectivity value of Channel data 1
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1. Calculate distance based on distance data in the data packet:

1）Find the distance value in the data packet and convert to a hexadecimal number: 0x02, 0x76

2）Convert to a 16-bit unsigned integer: 0x0276

3）Convert to a decimal number: 630

Divide by 100 to obtain the actual value: 6.30

4）Calculate according to the distances resolution

5）Result: 6.30*0.5 = 3.125m.

2. Calculate azimuth based on azimuth data in the data packet:

1）Find the azimuth value in the data packet and convert to a hexadecimal number: 0x5c, 0x19

2）Convert to a 16-bit unsigned integer: 0x5c19

3）Convert to a decimal number: 23577

Divided by 100。

4）Result：235.77 degrees

5.2.2.2. Azimuth Value

The azimuth value of each data block is the azimuth value reported by the first laser of the firing
sequence of this data block. Azimuth value is recorded by angle encoder with the zero position of
the angle encoder corresponding the zero degree of the azimuth value. The azimuth resolution is
0.01 degrees.

5.2.3. Tail

The Tail is 6 bytes in length, among which 4 bytes are reserved, and the other 2 bytes are 0x00
and 0xFF.

5.3.Device Info Output Protocol（DIFOP）

Device Info Output Protocol is abbreviated as DIFOP

I/O type: device output, computer read.

Default port number: 7788.

DIFOP is an "output-only" protocol to periodically send the LiDAR serial number (S/N), firmware
version information, host computer driver compatibility information, network configuration
information, calibration information, motor operating configuration, operating status, and fault
diagnosis information to users. By reading DIFOP, users can learn specific information of various
parameters of the LiDAR currently in use.

The basic structure of the DIFOP packet is as shown in the table below.
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Table 5-5 RS-Bpearl_2.0 DIFOP Packet Structure

Segments No. Information Registers Offset Length（byte）

Header 0 DIFOP header 0 8

Data

1 Motor speed 8 2

2 Ethernet 10 22

3 FOV setting 32 4

4 Reserved 36 2

5 Motor phase lock 38 2

6 Top board firmware version 40 5

7 Bottom board firmware version 45 5

8 Reserved 50 242

9 Serial number 292 6

10 Zero angle offset 298 2

11 Return mode 300 1

12 Upper computer compatibility 301 2

13 UTC time 303 10

14 Operating status 313 18

15 Reserved 331 11

16 Fault diagnosis 342 40

17 GPRMC 382 86

18 Corrected vertical angle 468 96

19 Corrected horizontal angle 564 96
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20 Reserved 660 586

Tail 21 Tail 1246 2

Table 5-6 RS-Bpearl_3.0 DIFOP Packet Structure

Segments No. Information Registers Offset Length（byte）

Header 0 DIFOP header 0 8

Data

1 Motor speed 8 2

2

Ethernet source IP 10 4

Ethernet destination IP 14 4

LiDAR MAC address 18 6

MSOP port number 24 2

Reserved 26 2

DIFOP port mumber 28 2

Reserved 30 2

3

FOV start angle 32 2

FOV end angle 34 2

4 TCPMSOP port number 36 2

5 Motor phase lock 38 2

6

Top board firmware version 40 5

Bottom board firmware version 45 5

Bottom board software version 50 5

Motor firmware version 55 5
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Reserved 60 3

7 Reserved 63 227

8 Reverse Zero angle offset 290 2

9 Serial number 292 6

10 Zero angle offset 298 2

11 Return mode 300 1

12

Time synchronization mode 301 1

Synchronization status 302 1

UTC Time 303 10

13 Operating status 313 18

14

Reserved 331 11

Rotation direction flag 337 1

Elapsed time flag 338 4

Fault diagnosis 342 40

15 GPRMC 382 86

16 Corrected vertical angle 468 96

17 Corrected horizontal angle 564 96

18 Reserved 660 586

Tail 19 Tail 1246 2

Note: The Header (the DIFOP identifier) in the table above is 0xA5,0xFF,0x00,0x5A,0x11,0x11,0x55,0x55, it can be

used to identify the packet. The tail is 0x0F,0xF0.

For detailed description of information registers as well as their usage, please refer to Appendix B
of this user manual.
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5.4.User Configuration Write Protocol (UCWP）

User Configuration Write Protocol is abbreviated as UCWP.

I/O type: Computer writes into the device.

Function: User can reconfigure Ethernet connection, time, motor and some other parameters of
the LiDAR.

Note: The UCWP is only available for the RS-Bpearl_2.0 sensors. The RS-Bpearl_3.0 uses the Web
Interface to configure the sensor. Please refer to Appendix A for detailed instructions of using
Web Interface for sensor configuration.

Each UCWP Packet is 48 bytes long, and is comprised of a 8-byte long Header and a 40-byte long
data block.

The UCWP packet structure is as shown in the table below:

Table 5-7 UCWP Packet Structure

Segments No. Information Registers Offset Length（byte）

Header 0 UCWP header 0 8

Data

1 Motor speed 8 2

2 Ethernet 10 22

3 FOV setting 32 4

4 Time 36 10

5 Motor phase lock 46 2

Note: The Header (UCWP identifier) in the table above is 0xAA,0x00,0xFF,0x11,0x22,0x22,0xAA,0xAA, among

which, the first 4 bytes 0xAA, 0x00, 0xFF, 0x11 forms the sequence to identify the packet.

Reminder: RS-Bpearl doesn’t have a battery system to support the continuous operation of the
RTC while the sensor power is off. In the case of no GPS or no GPS signal, it is imperative to write
time into the sensor through a computer, otherwise a default system time will be used for the
sensor timing.

Please refer to Appendix B for the detailed definition of the Ethernet, Time, Motor Speed and
Motor Phase Lock.

If the user wants to reconfigure the LiDAR IP to 192.168.1.105, the destination PC IP to
192.168.1.225, the MAC_ADDR to 001C23174ACC, the MSOP port to 6688, the DIFOP port to
8899, the FOV start angle to 0 degrees, and the FOV end angle to 120 degrees, time
9:45:30:100:200 on March 10, 2017, motor speed to 600rpm, and the motor phase lock angle to
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90 degrees, according to the definition of the UCWP Packet and each registers, you can send UDP
packets to LiDAR according to the following table.

Table 5-8 Example Configuration of LiDAR through UCWP

Information Registers Setting Configuration Length (byte）

Header
0xAA,0x00,0xFF,0x11,0x22,0x

22,0xAA,0xAA
8

Motor Speed 600rpm
0x02

0x58
2

LiDAR IP

（LIDAR_IP）
192.168.1.105

0xC0

0xA8

0x01

0x69

4

Destination PC IP

（DEST_PC_IP）
192.168.1.225

0xC0

0xA8

0x01

0xE1

4

LiDAR MAC Address

（MAC_ADDR）
001C23174ACC

0x00,0x1C,0x23,

0x17,0x4A,0xCC
6

MSOP Port（port1） 6688 0x1A20 2

MSOP Port（port2） 6688 0x1A20 2

DIFOP Port（port3） 8899 0x22C3 2

DIFOP Port（port4） 8899 0x22C3 2

FOV start angle 0 0x0000 2

FOV end angle 12000 0x2EE0 2

UTC_Time Year:2017 Month:3

Day:10 Hour:9
0x11 10
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Minute:45 Second:30

Millisecond: 100

Microsecond: 200

0x03

0x0A

0x09

0x2D

0x1E

0x00,0x64

0x00,0xC8

Motor Phase Lock 90 0x005A 2

While configuring LiDAR according to this protocol, it is imperative to configure all the
information registers in the table above. Configuring only part of it will lead to invalid
configuration. Configuration will take effect once the parameters are changed, except that the
network parameters will take effect during the initialization process when the LiDAR is restarted.

Note: RSVIEW provides the LiDAR configuration user interface. Except for the UCWP, user can also
use the RSVIEW to configure the RS-Bpearl. When performing the parameter configuration,
please make sure there is stable power supply for the LiDAR. After the parameter configuration is
done, please make sure to power off the LiDAR, otherwise there is a risk of parameter configuring
error.
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6. Vertical Angles and Exact Point Time Calculation
6.1.Channel Number and Vertical Angles

The RS-Bpearl LiDAR comes with a total of 32 laser heads vertically allocated along the vertical
field of view of 90 degrees with non-uniform angular resolution. Each laser head, also called a
laser channel, is installed with a designated vertical angle; Due to errors in actual assembly
processes, users can check the DIFOP data packets for the calibrated vertical angule value of each
laser channels.

6.2.Exact Point Time Calculation
6.2.1. Exact Point Time Calculation in Single Return Mode

In single return mode, each MSOP Packet has 12 data blocks and each data block stores
measurements of 1 firing sequences of 32 lasers, therefore, each MSOP Packet records 12 firing
sequences of 32 lasers. It takes 55.52us to complete one sequence of firing and recharging of the
32 lasers: The time to complete 32 laser shooting 1.28us * 32=40.96us (time interval between 2
laser shooting is 1.28us), plus the time cost for two laser charge, the wait time after each charge
and the reference signal time 2 * 4.00us + 2 * 1.20us + 4.16us=14.56us.

After the first laser charge, the RS-BPearl will complete the shooting from channel 1 to channel 8
and channel 17 to channel 24. Then a second laser charge and complets the shooting from
channel 9 to channel 16 and channel 25 to channel 32.

The laser number(data_index) is defined as laser 1 to 32, and the laser firing sequence
number(sequence_index) is defined as sequence 1 to 12. The time stamp of each MSOP packet is
the time stamp of the first laser shooting (laser point), to calculate the exact time of each laser
shooting(laser point), a time offset(time_offset) needs to be added to the time stamp.

The time offset of channel 1 to channel 8 and channel 17 to channel 24 is calculated as:

Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index – 1) , 16) + 1.28 *
floor((data_index-1) / 16)

The time offset of channel 9 to channel 16 and channel 25 to channel 32 is calculated as:

Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index – 1) , 16) + 1.28 *
floor((data_index-1) / 16) + 5.2

The exact time of each laser point is calculated as:

Exact_point _time = Timestamp + Time_offset

Table 6-1 Time Offset of each Laser Point in the MSOP Packet in the Single Return Mode
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6.2.2 Exact Point Time Calculation in Dual Return Mode

In dual return mode, each MSOP Packet has 12 data blocks and each 2 data blocks store the dual
return measurements of 1 firing sequences of 32 lasers, for example, Block 1 and Block 2 store
the dual return measurements of 1 firing sequences of 32 lasers, where Block 1 stores the
strongest return measurements, Block 2 stores the last return measurements.

The laser number(data_index) is defined as laser 1 to 32, and the laser firing sequence
number(sequence_index) is defined as sequence 1 to 12. The time stamp of each MSOP packet is
the time stamp of the first laser shooting(laser point), to calculate the exact time of each laser
shooting(laser point), a time offset(time_offset) needs to be added to the time stamp.

The time offset of channel 1 to channel 8 and channel 17 to channel 24 is calculated as:

Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 2.56 * mod((data_index – 1) , 16) +
1.28 * floor((data_index-1) / 16)

Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 2.56 * mod((data_index – 1) , 16) +
1.28 * floor((data_index-1) / 16) + 5.2

The exact time of each laser point is calculated as:

Exact_point _time = Timestamp + Time_offset
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Table 6-2 Time Offset of each Laser Point in the MSOP Packet in the Dual Return Mode
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7. Trouble Shooting

When using the RS-Bpearl, users may encounter some common problems, this chapter lists some
common problems and the corresponding solutions.

Problem Solution

The red LED indicator in

the Interface Box is off

or blinking

 Check whether the input power connection and polarity are normal.

 Check whether the voltage and current of the input power supply meet

the requirements (voltage input≤12V, input current≥3A).

The red LED indicator in

the Interface Box is on

but the green LED is off or

blinking

 Check if the connection cable between the Interface Box and the LiDAR

gets loose.

LiDAR motor does not

rotate

 Check whether the LED indicators on the Interface Box are normal, and

check whether the power input is normal.

 Check if the connection cable between the Interface Box and the LiDAR

gets loose.

LiDAR keeps restarting at

startup

 Check whether the input power connection and polarity are normal.

 Check whether the voltage and current of the input power supply meet

the requirements (voltage input≤12V, input current≥3A).

 Check whether the mounting base of the device is level or whether the

fixing screws at the bottom of the LiDAR are too tight.

LiDAR rotates but no data

output

 Check whether the network connection is normal.

 Check whether the computer network configuration is correct.

 Use another software (such as wireshark) to check whether the packet

output is normal.

 Turn off firewalls and other security software that may block the

network.

 Check whether the power supply is normal.

Can see data in Wireshark

but not in RSVIEW

 Turn off the computer firewall, and allow the RSVIEW to bypass the

firewall.

 Make sure that the IP of the computer is consistent with the IP of the
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LiDAR.

 Make sure that the Data Port setting on RSVIEW is correct.

 Make sure that the RSVIEW installation directory or configuration file

storage directory only contain English characters.

 Make sure that the data packets received by wireshark are MSOP

packets.

Frequent data dropouts

 Check whether there is excessive traffic and/or collisions on network.

 Check whether there are other network devices in the network sending

excessive broadcast packets, which slows the sensor down.

 Check whether the computer or the interfaces are fast enough to meet

the packet flow requirements.

 Remove all other network devices and directly connect sensor to the

computer to test whether there is packet loss.

GPS/PTP not

synchronizing

 Make sure that the GPS baud rate is 9600bps and serial port set to 8N

1(8 bits, no parity, 1 stop bit).

 Check whether the GPS signal level RS232.

 Make sure that the 1PPS pulse is continuous and the connection is

correct.

 Make sure that the GPRMC message of NMEA is correct.

 Make sure that the GPS and Interface Box share the same ground.

 Make sure that the GPS has received valid message.

No data output when

sensor connected to a

router

 Turn off the DHCP function of the router or set the IP of the sensor to

the correct IP inside the router.

Abnormal shape of point

cloud
 Make sure that the configuration file of the LiDAR is correct.

In the point cloud, there

is a fixed blank area that

continuously rotates

 This phenomenon is normal, because the ROS driver performs frame

display according to a fixed number of packets, and the blank part of the

data will be displayed in the next frame.

RSVIEW software outputs

point cloud into a ray

 If you are using a windows 10 system, please set RSVIEW to run in the

mode compatible with windows 7.
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Appendix A Web Interface

The parameter setting of the RS-Bpearl_2.0 can only be done through RSVIEW, please refer to
Appendix C for detailed instructions. While the parameter setting, operation status-check and
firmware upgrade of the RS-Bpearl_3.0 can only be done through the Web Interface.

The address of the Web Interface of the RS-Bpearl changes with the LiDAR IP. The factory default
LiDAR IP is 192.168.1.200. If the user has changed the LiDAR IP, the address of the Web Interface
will be changed to the newly set LiDAR IP address.

After the LiDAR is correctly connected and configured according to the requirements, user can
use the computer connected to the LiDAR to access the LiDAR IP address (default Device IP
"192.168.1.200") to enter the homepage of the LiDAR web interface, the homepage defaults to
the "Device" page.

A.1 Device Information Screen

After accessing the LiDAR Web Interface, you will be at the “Device” screen directly, which shows
information of the LiDAR currently in use:

Figure A-1 Homepage of the Web Interface

1. Top Board: the top board firmware version;

2. Bottom Board: the bottom board firmware version;

3. Software Version: the software version;

4. S/N: the sensor serial number;

5. Model: the product model number;

6. Web App Version: the version of the current Web Interface.
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A.2 Device Parameter Setting Screen

Click the Setting button on the Web Interface, you will open the “Setting” screen, where you will
find settings for Device IP, port number, return mode, rotation speed, etc. Definition of the
functionality and features are as shown in the figure below:

Figure A-2 -1 Setting LiDAR Parameters at the Web Interface

1. Communication of LiDAR supports both unicast (default) and broadcast modes. Destination IP
address 255.255.255.255 indicates broadcast mode. The default factory setting of the
Destination IP is 192.168.1.102;

2. The MSOP and DIFOP port numbers can be configured in a range from 1025 to 65535;

3. The Return Mode has three options: Last(default), Strongest and Dual;

4. The FOV can be set from 0° to 360°, when set, only the point cloud of the set FOV will be
output.

5. The sensor rotation speed can be set, which only 300rpm, 600rpm(default), and 1200rpm are
supported at the moment;

6. The Time Synchronization Source has options: GPS(default), PTP-E2E, PTP-P2P, PTP-GPTP;

7. The Rotation direction has 2 options: forward(default), reversal;

8. Click the dropdown menu of "Operation Mode", users can select the working mode between
Standby and Balance(default). When the Standby mode is selected, the LiDAR motor and
transmitter will stop working.

Note：
1. Please make sure that the Device IP and Destination IP are at the same network segment, otherwise, LiDAR

connection error may occur;

2. The MSOP and DIFOP port number can be set within a range from 1025 to 65535;

3. Please click “Save” after each modification. A system reminder of modification success will appear if the
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modification takes effect.

A.3 Device Diagnostics/Operation Status Screen

Click the Diagnostic button on the front page of the Web Interface, you will see the Diagnostic
Screen, where you can learn the operating status of the LiDAR in real time, including the input
voltage, current, rotating speed, operating time, and temperature, etc. The figure below shows
the Diagnostic screen and the features:

Figure A-3 Device Diagnostic/Operation Status Screen at the Web Interface

Description:

1. Voltage Monitor: Users can view the real time voltage of the power supply of the LiDAR;

2. Temperature: Users can view the real time operating temperature of the LiDAR;

3. RPM: Users can view the real time motor rotating speed, when the LiDAR operation mode is
set as Standby, the motor rotating speed will be 0;

4. Laser Status: The laser status has two options of “On” and “Off”.

(1) When laser status is “ON”, the LiDAR is operating normally;

(2) When laser status is ”Off”, the LiDAR operation encounters problems;

when the LiDAR operation mode is set as Standby, the laser status is “Off”;

5. GPS Status/PTP Status: Users can view the time synchronization status;

6. Start-up Times: Users can view the total number of Star-ups of the LiDAR, which will be
accumulated every time the LiDAR is restarted;

7. Elapsed time Total T0: Users can view the total operation time of the LiDAR and the
accumulated operation time of the LiDAR at each temperature range.
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Note:

1. The diagnostic screen is refreshed every second.

2. If the voltage/current box turns red, please check whether the LiDAR is currently in Standby mode, if not, check

whether the LiDAR is working normally;

3. After the LiDAR is circle powered again, within 10 minutes of operation, the number of start-up times is

refreshed every 1 minute; after 10 minutes of operation, the number of start-up times is refreshed every 30

minutes.

A.4 Device/System Update Screen

Click the System button on the front page of the Web Interface, you will see the System Screen,
where you can update the top board firmware, bottom board firmware, software, web app,
motor firmware, and config file. The procedure of device update, taking the Top Board Firmware
Update as an example, are as shown below:

1. Prepare the Top Board firmware that is going to be used for the update. Click the Choose File
button to navigate to the folder where the new TOP Board firmware is located.

Figure A-4 Click Choose File to Find the New Firmware

2. Select the right firmware that is going to be used for the update, and click Open to upload the
file. (The saving path of the firmware should only contain English characters)
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Figure A-5 Select the Right Firmware

3. When the new firmware is successfully uploaded, the file name of the firmware will appear in
the box behind the Top Board Firmware Update, click Update to initiate the update process.

Figure A-6 Click Update

4. After the Update process completes, the Web Interface will prompt Update Successful, and the
LiDAR will automatically restart, after the sensor is restarted, load the Web Interface again to
check if the firmware update is successful.
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Figure A-7 Update Successful
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Appendix B Information Registers

Here are definitions and more details on the information registers as mentioned in Section 5.

B.1 Motor Speed (MOT_SPD)

MOT_SPD (2 bytes in total)

Byte No. byte1 byte2

Function MOT_SPD

Register description:

(1) This register is used to configure the motor rotation direction and motor speed;

(2) The data storage adopts the big-endian format.

(3) Supported rotation speed:

(byte1==0x04) && (byte2==0xB0): speed 1200rpm, clockwise rotation;

(byte1==0x02) && (byte2==0x58): speed 600rpm, clockwise rotation;

(byte1==0x02) && (byte2==0x58): speed 300rpm, clockwise rotation;

If set with data other than the above described, the rotation speed of the motor is 0.

B.2 Ethernet(ETH)

ETH (22 bytes in total）

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function LIDAR_IP DEST_PC_IP

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

Function MAC_ADDR port1

Byte No. byte17 byte18 byte19 byte20 byte21 byte22

Function port2 port3 port4

Register description:

(1) LIDAR_IP is the source IP address of the LiDAR. It takes 4 bytes

(2) DEST_PC_IP is the IP address of the destination PC. It takes 4 bytes
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(3) MAC_ADDR is the LiDAR MAC address.

(4) port1 to port4 are port number information.

port1 is the port for LiDAR to output MSOP packets and port2 is the port for destination PC to
receive MSOP packets. port3 is the port for LiDAR to output DIFOP packets and port4 is the port
for destination PC to receive DIFOP packets. By default, we suggest port1 and port2 to be set the
same, port3 and port4 to be set the same.

B.3 FOV Setting(FOV_SET)

FOV_SET (4 bytes in total)

Byte No. byte1 byte2 byte3 byte4

Function FOV_START FOV_END

Register Description:

Set the azimuth range that the sensor can output valid data, the values of FOV_START and
FOV_END could be any integer between 0 to 36000, corresponding 0~360°, the data storage
adopts the big endian ordering. For example: byte1 = 0x5d，byte2 = 0xc0，byte3 = 0x1f，byte4 =
0x40, therefore:

FOV_START = 93*256+192=24000

FOV_END = 31*256+64=8000

Which indicates that the azimuth range for valid data output is from 240.00° to 80.00° in
clockwise direction.

Note: In all above calculations, bytes have been converted from hexadecimal to decimal.

B.4 TCP MSOP Port Number

TCP MSOP(2bytes in total)

Byte No. byte1 byte2

Function Port

Register Description:

MSOP port number setting in the TCP communication mode.

B.5 Motor Phase Offset(MOT_PHASE)

MOT_PHASE(2 bytes in total)
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Byte No. byte1 byte2

Function MOT_PHASE

Register description:

This register can be used together with the PPS pulse of GPS to adjust the phase offset of the
motor at the top of seconds. The value can be set from 0 to 360 corresponding 0 to 360°. The
data storage adopts the big endian ordering. For example: the byte1=0x01、byte2=0x0e, so the
motor phase should be 1*256+14 = 270.

Note: In all above calculations, bytes have been converted from hexadecimal to decimal.

B.5 Top Board Firmware Version(TOP_FRM)

TOP_FRM(5 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5

Function TOP_FRM

Register description：

This register corresponds to the top board firmware version:

For RS-Bpearl_2.0:

Top board firmware file version: T6R23V6_T6_A

Top board firmware version displayed in DIFOP packets: 06 23 06 06 A0

The mark "_A" in the version number means that the firmware is for Application purpose, and
"_F" means that it is the factory version.

For RS-Bpearl_3.0:

Top board firmware file version: 03010303

Top board firmware version displayed in DIFOP packets:00 03 01 03 03

B.6 Bottom Board Firmware Version(BOT_FRM)

BOT_FRM(5bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5

Function BOT_FRM

Register description：
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For RS-Bpearl_2.0:

Bottom board firmware file version: B7R14V4_T1_F

Top board firmware version displayed in DIFOP packets: 07 14 04 01 F0

The mark "_A" in the version number means that the firmware is for Application purpose, and
"_F" means that it is the factory version.

For RS-Bpearl_3.0:

Bottom board firmware file version: 03011300

Top board firmware version displayed in DIFOP packets: 00 03 01 13 00

B.7 Software Version(SOF_FRM)

SOF_FRM (5 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5

Function SOF_FRM

Register description:

This register corresponds to the Software Firmware version:

Software firmware file version: 21101904

Software firmware version displayed in DIFOP packets: 00 21 10 19 04

B.8 Motor Firmware Version(MOT_FRM)

MOT_FRM (5 bytes in total)

序号 byte1 byte2 byte3 byte4 byte5

功能 SOF_FRM

Register description:

This register corresponds to the Motor Firmware version:

Motor firmware file version: 21061600

Motor firmware version displayed in DIFOP packets: 00 21 06 16 00

B.9 Time Synchronization(TIMESTAMP_VER）

TIMESTAMP_VER (2 bytes in total)
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Register description:

（1）byte1: Time synchronization mode

00：GPS

01：E2E

02：P2P

03：gptp

byte2: Time synchronization status

00：Time synchronization invalid

01：GPS Time synchronization successful

02：PTP Time synchronization successful

B.10 UTC Time(UTC_TIME)

UTC_TIME (10 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function year month day hour min sec ms

Byte No. byte9 byte10

Function us

Register description:

1) year

reg name：set_year

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function set_year[7:0]: 0~255 corresponds 2000~2255 year

Byte No. byte1 byte2

Function Timestamp_setting Timestamp_State
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2) month

reg name：set_month

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function Reserved Reserved Reserved Reserved set_month[3:0]：1~12 month

3) day

reg name：set_day

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function Reserved Reserved Reserved set_day[4:0]：1~31 day

4) hour

reg name：set_hour

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function Reserved Reserved Reserved set_hour[4:0]：0~23 hour

5) min

reg name：set_min

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function Reserved Reserved set_min[5:0]：0~59 min

6) sec

reg name：set_sec

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0
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Function Reserved Reserved set_sec[5:0]：0~59 sec

7) ms

reg name：set_ms

Byte No. bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8

Function Reserved Reserved Reserved Reserved Reserved Reserved ms[9:8]

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function set_ms[7:0]

Note: set_ms[9:0], value range: 0~999

8) us

reg name：set_us

Byte No. bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8

Function Reserved Reserved Reserved Reserved Reserved Reserved us[9:8]

Byte No. bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Function set_us[7:0]

Note: set_us[9:0], value range: 0~999

B.11 Operation Status(STATUS)

B.11.1 Operation Status (valid for RS-Bpearl 2.0)

STATUS (18 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function Idat1_reg Idat2_reg Vdat_12V_reg

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16
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Function Vdat_12V_M_reg Vdat_5V_reg Vdat_3V3_reg Vdat_2V5_reg

Byte No. 17byte 18byte

Function Vdat_1V2_reg

Register description:

(1) Idat, including 2 current values, where Idat1 is the sensor power supply current, and Idat2 is
the top board power supply current. Idat_reg contains 3 bytes to be Idat_reg[23:0]. The highest
bit Idat_reg[23] is the sign flag bit, Idat_reg[23] = 1 means a negative value, and Idat_reg[23] = 0
means a positive value. Idat_reg[22:0] corresponds to the current value, the LSB is 1uA, and the
current calculation formula is:

�dat=
����_���[22: 0]⋯⋯⋯(����_���[23] = 0)
− ����_���[22: 0]⋯⋯(����_���[23] = 1)

For example, if byte1 = 0x8C, byte2 = 0xD5, byte3 =0x 00, the actual current value is:

Idat = -Idat_reg[22:0] = -0x0CD500 uA = -840960uA≈-841mA

(2) Vdat, including 6 voltage values, each Vdat_reg contains 2 bytes to be Vdat_reg[15:0]. The
upper 4 bits of Vdat_reg[15:12] data are invalid. Vdat_reg[11:0] corresponds to the voltage value,
and the calculation formula of each voltage is as follows:

The unit used in the above calculations is volt (V).

B.11.2 Operation Status (valid for RS-Bpearl 3.0)

STATUS (18 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function Reserved Vdat_0V5_reg

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16
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Function Vdat_12V__reg Vdat_5V_reg Vdat_1V25_reg Vdat_0V_reg

Byte No. 17byte 18byte

Function Vdat_1V_reg

Note: [Value] is the decimal value obtained by converting the corresponding offset byte, using big-endian mode,

with the high order first and the low order last.

Register description:

Vdat, including 6 voltage values, each Vdat_reg contains 2 bytes. The calculation formula of each
voltage is as follows:

Vdat_0V5_reg = value/4096 V

Vdat_12V_reg = value/4096x24.5 V

Vdat_5V_reg = value/4096x11 V

Vdat_1V25_reg = value/4096x3 V

Vdat_0V_reg = value/4096x3 V

Vdat_1V_reg = value/4096x3 V

The unit used in the above calculations is volt (V).

B.12 Fault Diagnosis (FALT_DIGS)

B.12.1 Fault Diagnosis(valid for RS-Bpearl 2.0)

Fault Diagnosis (40bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function internal debug

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

Function internal debug cksum_st manc_err1 manc_err2 gps_st

Byte No. byte17 byte18 byte19 byte20 byte21 byte22 byte23 byte24

Function temperature1 temperature2 temperature3 temperature4

Byte No. byte25 byte26 byte27 byte28 byte29 byte30 byte31 byte32
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Function temperature 5 internal debug r_rpm1

Byte No. byte33 byte34 byte35 byte36 byte37 byte38 byte39 byte40

Function r_rpm2 internal debug

Register description:

(1) The cksum_st of byte11 in the table shows the error status in reading the checksum of the
temperature drift compensation value of the EEPROM. cksum=0x00 means that the temperature
drift compensation value is normal and available, cksum=0x01 means that the temperature drift
compensation value is abnormal, and the FPGA internal temperature drift correction has error.

(2) manc_err1 and manc_err2 are used to calculate the count of the bit error of data
communication transmission, manc_err1 is used to calculate the count of 1bit errors, and
manc_err2 is used to calculate the count of 2bit errors. The formula for calculating the bit error
rate is as follows:

����_���1_��� = ����_���1/65536 ∗ 100%

����_���2_��� = ����_���2/65536 ∗ 100%

When manc_err1_per or manc_err2_per is 0, the communication transmission value is normal.

(3) temperature1, temperature2 are the bottom board temperature, temperature3,
temperature4 are the top board temperature. The temperature value consists of 2 bytes, and the
lower 3 bits of temperature[2:0] are meaningless. The high 13-bit temperature[15:3] is the
effective temperature value, of which the highest bit temperature[15] is the sign flag bit,
temperature[15] = 0 means a positive value, and temperature[15] = 1 means a negative value.
The temperature calculation formula is as follows:

�����������1_4 =
�����������[15: 3] /16 (�����������[15] = 0)
− ((8192 − �����������[15: 3])/16) (�����������[15] = 1)

Temperature5 is the bottom board temperature, which consists of 2 bytes, and the high 4 bits
temperature[15:12] data are meaningless. The lower 12 bits temperature[11:0] are the effective
temperature values, the highest bit temperature[11] is the sign flag bit, temperature[11] = 1
means a negative value, and temperature[11] = 0 means a positive value. The temperature
calculation formula is as follows:

�����������5 =
�����������[11: 0]/4 (�����������[11] = 0)

− (4096 − �����������[11: 0])/4 (�����������[11] = 1)

(4) byte16 is the GPS signal input status register gps_st, which uses 3 bits to indicate whether the
currently connected PPS signal and GPRMC signal are valid, and at the same time indicate
whether the current system time is the local time of the device or the synchronized UTC time.
The bits are defined as follows:
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GPS input status register GPS_ST

BIT Function Value Status

bit0 PPS_LOCK 0 PPS is invalid

1 PPS is valid

bit1 GPRMC_LOCK 0 GPRMC is invalid

1 GPRMC is valid

bit2 UTC_LOCK 0 LiDAR internal timestamp is not synchronizing the UTC.

1 LiDAR internal timestamp is synchronizing the UTC.

bit3~bit7 Reserved x N/A

(1) The real-time rotation speed of the motor is composed of two bytes, byte32 and byte33. The
calculation formula is as: Motor real-time rotation speed = (256 * r_rpm1 + r_rpm2)÷6
(2) The reset is used for internal debug,

B.12.2 Fault Diagnosis(valid for RS-Bpearl 3.0)

Fault Diagnosis (40bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

Function Reserved

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

Function Reserved manc_err1 manc_err2 gps_st

Byte No. byte17 byte18 byte19 byte20 byte21 byte22 byte23 byte24

Function Temp1 Temp2 Reserved Temp3 Temp4 Temp5 Temp6

Byte No. byte25 byte26 byte27 byte28 byte29 byte30 byte31 byte32

Function Reserved r_rpm1

Byte No. byte33 byte34 byte35 byte36 byte37 byte38 byte39 byte40
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Function r_rpm2 Reserved

Note: [Value] is the decimal value obtained by converting the corresponding offset byte, using big-endian mode,

with the high order first and the low order last.

Register description:

(1) manc_err1 and manc_err2 are used to calculate the error of data communication
transmission, manc_err1 is used to calculate the count of 1bit errors, and manc_err2 is used to
calculate the count of more than 1bit errors.

When manc_err1_per or manc_err2_per is 0, the communication transmission value is normal.

(2) temp1, temp2 is the temperature of the bottom board, the temperature value is composed of
2bytes, and the temperature calculation formula is:

Temp=（Value（tamp1）*256+Value（tamp2）&0Xffff）*503.975/4096.0-273.15

(3) temp3 and temp4 are APD temperatures, the temperature value is composed of 2 bytes, and
the temperature calculation formula is:

When Value≤32768, the temperature value is positive; the calculation formula is as follows:

temp= ( (value(362)*256 + value(363) ) & 0x7FF8 ) /128.0

When Value>32768, the temperature value is negative; the calculation formula is as follows:

temp= ( (value(362)*256 + value(363) ) & 0x7FF8 ) /128.0

(4) temp5 and temp6 are the temperature of the top board. The temperature value is composed

of 2 bytes. The temperature calculation formula is as follows:

When Value≤32768, the temperature value is positive; the calculation formula is as follows:

temp= ( (value(362)*256 + value(363) ) & 0x7FF8 ) /128.0

When Value>32768, the temperature value is negative; the calculation formula is as follows:

temp= ( (value(362)*256 + value(363) ) & 0x7FF8 ) /128.0

(5) byte16 is the GPS signal input status register gps_st, which uses 3 bits to indicate whether the
currently connected PPS signal and GPRMC signal are valid, and at the same time indicate
whether the current system time is the local time of the device or synchronized UTC time. The
bits are defined as follows:

GPS input status register GPS_ST

BIT Function Value Status

bit0 PPS_LOCK 0 PPS lock invalid
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1 PPS lock valid

bit1

GPRMC_LOCK 0 GPRMC lock invalid

1 GPRMC lock valid

bit2 UTC_LOCK

0 LiDAR internal timestamp is not synchronizing the UTC.

1 LiDAR internal timestamp is synchronizing the UTC.

bit3
GPRMC input

status

0 No GPRMC input

1 with GPRMC input

bit4 PPS input status

0 No PPS input

1 with PPS input

bit5~bit7 Reserved x N/A

(1) The real-time rotation speed of the motor is composed of two bytes, byte32 and
byte33. The calculation formula is as follows:

Motor real-time rotation speed = (256 * r_rpm1 + r_rpm2)÷6

B.13 ASCII Code in GPRMC Packet

GPRMC register reserve 86 bytes, it stores the whole GPRMC message from GPS module to the
register in ASCII code.

B.14 Corrected Vertical Angle(COR_VERT_ANG)

COR_VERT_ANG (48bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 byte9

Function Channel 1_COR_VERT_ANG Channel 2_COR_VERT_ANG Channel 3_COR_VERT_ANG

Byte No. byte10 byte11 byte12 byte13 byte14 byte15 byte16 byte17 byte18

Function Channel 4_COR_VERT_ANG Channel 5_COR_VERT_ANG Channel 6_COR_VERT_ANG

Byte No. byte19 byte20 byte21 byte22 byte23 byte24 byte25 byte26 byte27

Function Channel 7_COR_VERT_ANG Channel 8_COR_VERT_ANG Channel 9_COR_VERT_ANG
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Byte No. byte28 byte29 byte30 byte31 byte32 byte33 byte34 byte35 byte36

Function Channel 10_COR_VERT_ANG Channel 11_COR_VERT_ANG Channel 12_COR_VERT_ANG

Byte No. byte37 byte38 byte39 byte40 byte41 byte42 byte43 byte44 byte45

Function Channel 13_COR_VERT_ANG Channel 14_COR_VERT_ANG Channel 15_COR_VERT_ANG

Byte No. byte46 byte47 byte48 byte49 byte50 byte51 byte52 byte53 byte54

Function Channel 16_COR_VERT_ANG Channel 17_COR_VERT_ANG Channel 18_COR_VERT_ANG

Byte No. byte55 byte56 byte57 byte58 byte59 byte60 byte61 byte62 byte63

Function Channel 19_COR_VERT_ANG Channel 20_COR_VERT_ANG Channel 21_COR_VERT_ANG

Byte No. byte64 byte65 byte66 byte67 byte68 byte69 byte70 byte71 byte72

Function Channel 22_COR_VERT_ANG Channel 23_COR_VERT_ANG Channel 24_COR_VERT_ANG

Byte No. byte73 byte74 byte75 byte76 byte77 byte78 byte79 byte80 byte81

Function Channel 25_COR_VERT_ANG Channel 26_COR_VERT_ANG Channel 27_COR_VERT_ANG

Byte No. byte82 byte83 byte84 byte85 byte86 byte87 byte88 byte89 byte90

Function Channel 28_COR_VERT_ANG Channel 29_COR_VERT_ANG Channel 30_COR_VERT_ANG

Byte No. byte91 byte92 byte93 byte94 byte95 byte96

Function Channel 31_COR_VERT_ANG Channel 32_COR_VERT_ANG

Register description:
(1) The angle value is divided into positive and negative values. The vertical angle of each
channel consists of 3 bytes, of which the first byte represents positive or negative of the value,
and the second and third bytes represents the value of the angle, which is stored in big-endian
mode.
(2) The first byte 0x00 represents positive while 0x01 represents negative.
(3) LSB=0.01º.
(4) For example, the register for vertical angle of Channel 1 is as below: byte1=0x00, byte2=0x22
convert to decimal is 34, byte3=0XF6 convert to decimal is 246, so the vertical angle of Channel 1
is：

(34*256+ 246) *0.01º = 89.50º
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B.15 Corrected Horizontal Angle(COR_HOR_ANG)

COR_HOR_ANG (48 bytes in total)

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 byte9

Function Channel 1_COR_HOR_ANG Channel 2_COR_HOR_ANG Channel 3_COR_HOR_ANG

Byte No. byte10 byte11 byte12 byte13 byte14 byte15 byte16 byte17 byte18

Function Channel 4_COR_HOR_ANG Channel 5_COR_HOR_ANG Channel 6_COR_HOR_ANG

Byte No. byte19 byte20 byte21 byte22 byte23 byte24 byte25 byte26 byte27

Function Channel 7_COR_HOR_ANG Channel 8_COR_HOR_ANG Channel 9_COR_HOR_ANG

Byte No. byte28 byte29 byte30 byte31 byte32 byte33 byte34 byte35 byte36

Function Channel 10_COR_HOR_ANG Channel 11_COR_HOR_ANG Channel 12_COR_HOR_ANG

Byte No. byte37 byte38 byte39 byte40 byte41 byte42 byte43 byte44 byte45

Function Channel 13_COR_HOR_ANG Channel 14_COR_HOR_ANG Channel 15_COR_HOR_ANG

Byte No. byte46 byte47 byte48 byte49 byte50 byte51 byte52 byte53 byte54

Function Channel 16_COR_HOR_ANG Channel 17_COR_HOR_ANG Channel 18_COR_HOR_ANG

Byte No. byte55 byte56 byte57 byte58 byte59 byte60 byte61 byte62 byte63

Function Channel 19_COR_HOR_ANG Channel 20_COR_HOR_ANG Channel 21_COR_HOR_ANG

Byte No. byte64 byte65 byte66 byte67 byte68 byte69 byte70 byte71 byte72

Function Channel 22_COR_HOR_ANG Channel 23_COR_HOR_ANG Channel 24_COR_HOR_ANG

Byte No. byte73 byte74 byte75 byte76 byte77 byte78 byte79 byte80 byte81

Function Channel 25_COR_HOR_ANG Channel 26_COR_HOR_ANG Channel 27_COR_HOR_ANG

Byte No. byte82 byte83 byte84 byte85 byte86 byte87 byte88 byte89 byte90

Function Channel 28_COR_HOR_ANG Channel 29_COR_HOR_ANG Channel 30_COR_HOR_ANG
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Byte No. byte91 byte92 byte93 byte94 byte95 byte96

Function Channel 31_COR_HOR_ANG Channel 32_COR_HOR_ANG

Register description:
(1) The angle value is divided into positive and negative values. The horizontal angle of each
channel consists of 3 bytes, of which the first byte represents positive or negative of the value,
and the second and third bytes represents the value of the angle, which is stored in big-endian
mode.
(2) The first byte 0x00 represents positive, while 0x01 represents negative.
(3) LSB=0.01º.
(4) For example, the register for horizontal angle of Channel 10 is as below: byte1=0x01，
byte2=0x00 convert to decimal is 0, byte3=0x0A convert to decimal is 10, so the horizontal angle
of Channel 10 is：

-（0*256+10）*0.01=-0.1
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Appendix C RSView

This appendix gets you started with RSView. It shows you how to use the application to acquire,
visualize, save, and replay sensor data. You can also use other free tools, such as Wireshark or
tcp-dump. But RSView is free and relatively easy to use. The version used here is RSView3.1.12.

C.1 Software Features

RSView provides real-time visualization of 3D point cloud data from the RS-Bpearl LiDAR sensors.
RSView can also review pre-recorded data stored in .pcap (Packet Capture) files, but RSView still
does not support playing .pcapng files.

RSView displays distance measurements from the RS-Bpearl LiDAR sensor as point data. It
supports custom-colored display of variables such as intensity-of-return, time, distance, azimuth,
and laser ID. The data can be exported in CSV format.

Functionality and features of RSView include:

 Visualize live streaming sensor data over Ethernet

 Record live sensor data to pcap files

 Visualize sensor data from a recorded pcap file

 Different types of visualization modes, such as distance, time, azimuth, etc.

 Display point data in a spreadsheet

 Export point cloud data in CSV format

 Distance measurement tool

 Display multiple frames of data simultaneously (Trailing Frames)

 Display or hide subsets of lasers

 Crop views

C.2 Install RSView

Installer for RSView is provided for Windows 64-bit system and there is no need for other
dependencies. You can download the latest installer from RoboSense website
(https://www.robosense.ai/resources). The downloaded compressed file is an installation-free
version, and you can start using it directly by decompressing it. Make sure the decompressing
path only contains English characters.

C.3 Set Up Network

As mentioned in Section 3, the LiDAR has a factory default IP address to be sent to computer.
Therefore, by default, the static IP address of the computer needs to be set to 192.168.1.102, and
the subnet mask needs to be set to 255.255.255.0. In addition, you need to make sure that the
RSView is not blocked by firewalls or third-party security software.
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C.4 Visualize Streaming Sensor Data

1. Connect RS-Helios to power and connect to computer by network cable.

2. Right Click to start the RSView application with Run As Administrator.

3. Click on File > Open and select Sensor Stream (Figure C-1).

Figure C-1 RSView Open Sensor Stream

4. The Sensor Configuration dialog will appear. In “Type of Lidar”, chose RSBpearl. In “Intensity”,
chose Mode3. Then click OK, as shown in Figure C-2:

Figure C-2 Select RS-Bpearl Parameter Configuration File

5. Click the Tool to select Sensor Network Configuration to set the MSOP port number and
DIFOP port number corresponding to the RS-Bpearl.
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Figure C-3 MSOP and DIFOP Port Number Setting

6. RSView begins displaying the sensor data stream (Figure C-4). The stream can be paused by
pressing the Play button, pressing again, the stream resumes.

Figure C-4 Sensor Stream Data Display in RSView

C.5 Capture Streaming Sensor Data to PCAP File

1. Click the Record button when streaming (Figure C-5).

Figure C-5 RSView Record Button
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2. In the “Choose Output File” dialog that pops up, set the save path and file name, and then
click the Save (S) button (Figure C-6). RSView will start to write the packet file into the target pcap
file. (Note: RS-Bpearl will generate huge volume of data. As the recording time becomes longer,
the target pcap file will become larger. Therefore, it is better to save the recorded file to the HDD
or SSD instead of a slow subsystem such as a USB drive or network drive.)

Figure C-6 RSView Record Saving Dialog

3. Click the Record button again to stop saving pcap data.

C.6 Replay Captured Sensor Data from PCAP File

You can use RSView to replay or check the pcap file saved by RS-Bpearl. You can press the Play
button to play or select frames in the data that you are interested in. You can also use the mouse
to select a portion of 3D point cloud which the details will then be tabulated in a spreadsheet for
analysis. The saving path of the pcap file should only contain English characters.

1. Click File > Open and select Capture File

Figure C-7 Open the pcap record file

2. In the pop-up “Open File” dialog, select a recorded pcap file and click Open (O).
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Figure C-8 Open Recorded pacp File

3. In the pop-up “Sensor Configuration” dialog, add and select the correct RS-Bpear
configuration file and click the OK button.

4. Click the Play button to play or pause the data. Use the Scrub sliding tool to slide back and
forth to select frames at different positions in the data. This tool and the Record button are in the
same toolbar (Figure C-9)

Figure C-9 RSView Play Button and Scrub Tool

5. In order to get a more detailed analysis, select a frame of data that you are interested in and
click the Spreadsheet button (Figure C-10). A sidebar data table will be displayed on the right side
of the screen, which contains details of all the data of this frame

Figure C-10 RSView Spreadsheet Tool

6. You can adjust the width of each column of the table, or sort to get a better view.
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Figure C-11 RSView Spreadsheet Display

7. Click Show only selected elements in Spreadsheet to get the data corresponding to the
selected points (Figure C-12). If you didn’t select any elements, there will be no contents in the
Spresdsheet.

Figure C-12 RSView show only elements Tool

8. Click the Select All Points tool, which turns your mouse into a data point selection tool (Figure
C-13).

Figure C-13 RSView Select All Points Tool

9. In the 3D rendered data pane, use your mouse to draw a rectangle to frame some data points.
The data of these points will immediately populate the Spreadsheet and the selected data points
will turn pink in the data pane (Figure C-14).
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Figure C-14 RSView List Selected Points

10. Any selected points can be saved via Spreadsheet>Show only selected elements>Output
CSV data.

C.7 Configure LiDAR Parameters with RSView

Only the RS-Bpearl_2.0 LiDAR sensors can be configured by RSView, for the RS-Beparl_3.0, the
sensor configuration is done through the Web Interface (Please refer to Appendix A for details).

RSView provides a tool integrated with the UCWP protocol that can be used to configure the
motor speed, Ethernet, time synchronization, output angles and echo mode set by the factory
firmware.

When configuring the parameters of the RS-Bpearl factory firmware, it is necessary to first ensure
that the RS-Bpearl device has been normally connected and can display data in real time. Click
Tools > RS-LiDAR Information, and the configuration window will pop up. Click the Get button in
the window to display the parameters set by the current firmware of the RS-Bpearl.
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FigureC-15 RS-LiDAR Information

We can modify the parameters we want to set in the window (the red boxes are just examples),
and then click Set LiDAR. After a prompt indicating “modification successful” appears, check the
RS-LiDAR Information by clicking the Get button again to verify whether the parameters have
been modified successfully.

Figure C-16 Set LiDAR information

Note:

1. Before configuring the LiDAR paramenters at the RS-LiDAR Information screen, you must first
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click the Get button.

2. During the parameter setting process, make sure not to power off the LiDAR, otherwise the
modified parameters may not be saved successfully.

3. If the MSOP Port or DIFOP Port parameters set by the RS-Bpearl factory firmware are modified,
you need to configure the RSView Data Port according to Section C4.5 when reconnecting the
LiDAR.

C.8 Online Firmware Update with RSView

Firmware Update through RSView is only available for the RS-Bpearl_2.0 LiDAR sensors, the
RS-Bpearl_3.0 LiDAR sensors depends on the Web Interface for the update of sensor firmware.

To update LiDAR firmware through RSView, it is necessary to first ensure that the RS-Bpearl LiDAR
sensor has been normally connected, and can display the point cloud and obtain the factory
firmware information as shown in figure C.17.

Click Tools > Online Update, as shown in Figure C-17, you can select the top board update and
the bottom board Update.

Figure C-17Online Firmware Update with RSView

For example, after clicking Bottom Board Update, select the .rpd firmware file required for the
update in the pop-up window, and then click Open to start the update process, which will last for
some time. After the update is completed, a reminder of "Online Update Successful" will be
displayed.

Note: Config Updata is not available for the moment.
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Figure C-18 Select the Firmware File for the Update

Figure C-19 Online update successful reminder

C.10 Fault Diagnosis with RSView

Fault Diagnosis with RSView is only available for the RS-Bpearl_2.0 LiDAR sensors. Fault Diagnosis
for the RS-Bpearl_3.0 LiDAR sensors can only be done with the Web Interface. (Please refer to
Appendix A for details.)

To perform fault diagnosis with RSView, it is necessary to first make sure that the RS-Bpearl
sensor is normally connected and can display point cloud data and obtain factory firmware
information as shown in C.8.

Click Tools > Fault Diagnosis to pop up the Fault Diagnosis window. Click the Start button to start
monitoring the real-time status of the RS-Bpearl, including current, voltage, temperature, data
error rate and other information.
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Figure C-20 Fault Diagnosis
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Appendix D RS-Bpearl ROS&ROS2 Package

This appendix explains how to use Ubuntu+ROS or Ubuntu+ROS2 to acquire and visualize
RS-Bpearl data.

D.1 Install Software

1. Download and install Ubunutu 16.04 or Ubuntu18.04 operating system. (ROS2 users are
imperative to use the Ubuntu 18.04 system)

2. ROS users: Install and test the basic functions of ROS Kinetic according to the link
(http://wiki.ros.org/kinetic/Installation ). (For Ubuntu 18.04 users, please install ROS-melodic)

ROS2 users: Install and test the basic functions of ROS2 Eloquent according to the link
(https://index.ros.org/doc/ros2/Installation/Eloquent/).

3. Download and install libpcap-dev.

D.2 Download & Compile RoboSense LiDAR Driver Package

You can get the latest LiDAR driver package from
https://github.com/RoboSense-LiDAR/rslidar_sdk , or contact our technical support to get it.
After downloading, please read the README file in the driver package carefully, which describes
in detail how to compile and use the LiDAR driver package.

rslidar_sdk is our latest LiDAR driver package, which has included drivers for all RoboSense LiDAR
sensors. Three compilation modes are supported:

1. Direct Compilation

The user enters the main directory of the rslidar_sdk driver package and creates a build folder to
compile and run.

mkdir build

cd build

cmake .. && make

./rslidar_sdk_node

2. Compilation in ROS

Create ros working directory:

cd ~

mkdir -p catkin_ws/src

Copy the rslidar_sdk driver package to the ROS working directory ~/catkin_ws/src. Open the
CMakeLists.txt file in the rslidar_sdk driver package, and change the set (COMPILE_METHOD
ORIGINAL) at the top of the file to set (COMPILE_METHOD CATKIN). At the same time, rename
the package_ros1.xml file in the driver package to package.xml.

http://wiki.ros.org/kinetic/Installation
https://index.ros.org/doc/ros2/Installation/Eloquent/
https://github.com/RoboSense-LiDAR/rslidar_sdk
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Run the following command in the terminal to compile:

cd ~/catkin_ws

catkin_make

3. Compilation in ROS2

Create ros2 working directory:

cd ~

mkdir -p catkin_ws/src

Copy the rslidar_sdk driver package to the ROS2 working directory ~/catkin_ws/src. Open the
CMakeLists.txt file in the rslidar_sdk driver package, and change set(COMPILE_METHOD
ORIGINAL) at the top of the file to set(COMPILE_METHOD COLCON). At the same time, rename
the package_ros2.xml file in the driver package to package.xml.

Run the following command in the terminal to compile:

cd ~/catkin_ws

colcon build

D.3 Configure PC IP

In the default RS-Helios firmware, configure the static IP address of the computer to
"192.168.1.102", the subnet mask to "255.255.255.0". The gateway does not need to be
configured.

After the configuration is completed, you can use the ifconfig command to check whether the
static IP takes effect.

D.4 Real Time Display

There are detailed documents in the rslidar_sdk project to guide how to display the point cloud in
real time in the ROS or ROS2. Here is a brief introduction, taking the ROS as an example.

1. Connect the RS-Bpearl to the computer with a network cable, power on, run, and wait for the
computer to recognize the LiDAR.

2. Run the launch file provided in the rslidar_sdk driver package to start the node program that
displays data in real time. The launch file is located in rslidar_sdk/launch/start.launch. Open a
terminal and run:

cd ~/catkin_ws

source devel/setup.bash

roslaunch rslidar_sdk start.launch
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Figure D-1 rviz rviz displays RS-Bpearl point cloud data

D.5 View Offline Data

About how to parse data offline (rosbag or pcap), there is also a detailed introduction in the
documentation in the rslidar_sdk driver package. Here is just a brief introduction, taking pcap as
an example. You can use rslidar_sdk to parse the saved offline pcap file into point cloud data for
display.



RS-Bpearl User manual

78

Figure 15 D-2 config modifies RS-Bpearl LiDAR Information

1. Modify the parameters in rslidar_sdk/config/config.yaml

msg_source: modified to 3

pcap_path: configure to the absolute path of the pcap file: (e.g.
/home/robosense/RS_Bpearl.pcap)

Make sure there is a one-to-one correspondence between MSOP and DIFOP port numbers and
offline packets

2. Open the terminal and run the node program:

cd ~/catkin_ws

source devel/setup.bash

roslaunch rslidar_sdk start.launch
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Appendix E Mechanical Drawings
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Appendix F Sensor Mounting

Make sure the following requirements are met when mounting the LiDAR:

1) The mounting surface of the LiDAR should be flat and uneven surfaces should be avoided.

2) The precise locator pins on the mounting base should strictly follow the dimensions of the
locator holes at the bottom of the LiDAR, and the height of the locator pin should not be
higher than 4mm. We recommend using aluminum alloy for the mounting base material,
which facilitates heat dissipating of the LiDAR during operating.

3) If there are contact mounting surfaces on the top and bottom of the LiDAR, please ensure
that the distance between the mounting surfaces is greater than the height of the LiDAR to
avoid squeezing the LiDAR.

4) When connecting cables of the LiDAR, make sure not to pull the cable too tightly, and keep
the cables in a slack state.
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Appendix G Obtain MSOP and DIFOP Port Number from Data Packets

According to the description in Chapter 5, RS-Bpearl will output two types of packets, MSOP and
DIFOP packets. Users can use the wireshark tool to filter the packet content to distinguish the
output ports of MSOP and DIFOP packets, which can be used when setting the Data Port in
RSView.

Connect the LiDAR to computer, power on LiDAR, start wireshark, select the correct network port,
and start the packet capture process. Input the data.data[0:1]==55 expression in the application
display filter to filter out the MSOP packets, the MSOP port number is shown in the Info column,
as shown in Figure G-1; Input the data.data[0:1]==a5 expression, you will obtain the MSOP port
number, as shown in Figure G-2.

Figure G-1 use wireshark to filter out the MSOP port number

Figure G-2 Use wireshark to filter out DIFOP port number
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Appemdix H Sensor Cleaning

H.1 Attention

Please read the contents of this appendix H carefully and completely before cleaning your
RS-Bpearl LiDAR, otherwise improper operation may damage the LiDAR. When the LiDAR is used
in a harsh environment, it is necessary to clean up the dirt on the surface in time to keep the
LiDAR clean, otherwise it will affect the normal use of the LiDAR

H.2 Required Materials

1. Clean fiber cloth

2. Spray with neutral warm soap

3. Spray with clean water

4. Isopropanol solvent

5. Clean gloves

H.3 Cleaning Method

If there is only some dust adhered to the surface of the sensor, you can directly dip a small
amount of isopropanol solution with a clean fiber cloth, and then gently wipe the LiDAR surface
to clean, and then wipe it dry with a clean fiber cloth.

If the surface of the LiDAR is caked with mud or dirt, first spray clean water on the surface of the
dirty part to remove the mud or the dirt (Note: Do not try to wipe off the mud directly with a
fiber cloth, as this may scratch the surface, especially the optical ring lens.). Secondly, spray warm
soapy water on the dirty parts (The lubricating effect of soapy water can accelerate the
detachment of the dirt). Gently wipe the surface of the sensor with the fiber cloth again, be
careful not to scratch the surface. Finally, clean the soap residue on the surface with clean water
(If there are still residues on the surface, use an isopropyl alcohol solution to clean it again), and
wipe it dry with a clean microfiber cloth.
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